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Welcome to the CoDeSys Function Blocks and Libraries training module for the DCS800, ABB DC Drives.

If you need help navigating this module, please click the Help button in the top right-hand corner. To view
the presenter notes as text, please click the Notes button in the bottom right corner.
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Objectives

After completing this module, you will be able to
m Create new function blocks

m Implement function blocks into libraries
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After completing of this module, you will be able to
» Create new function blocks and
» Implement function blocks into libraries
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Create own function blocks

Overview about created blocks
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There can be an idea to put several functions into function blocks to hide know how. In
CoDeSys it is possible to create own function blocks and put them into libraries. Further the
user can define pictures for this blocks, like PID-controller. This function blocks are
integrated in a library and can protected with a password. In this case the program code isn’'t
visible for other users.
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Exercise 7: Create own function blocks

m With CoDeSys it is possible to create function blocks
and insert them into libraries

m The function blocks can protected by password

® |nputs and outputs can be selected and their data
types can be chosen

Example:

hlock1 hlock2
AND RS TON

In1-] SET $ Q1 IN @ Q outpuf
In2- RESET1 PT ET—

OR
Reset1~

Reset2+

MyOwn
In1 signall
In2 output
Resetl
Reset2
TimS

INT_TO_TIME
Times
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Let's do a little exercise. In the next exercise we build a new function block called “MyOwn”.
This block includes function blocks and operators from the CoDeSys standard library. The
difference between programs and function blocks are that the inputs and outputs must be
defined.



m Create a new project

m Opena PLC PRG
in CFC language

1. Create a new Object
- Right mouse click on POU
- Add Object

- Function Block

4. Language
> FBD

5. Fill out Name of the new
POU press OK
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2.
5.
2. Select 4 \

3. Choose 3.

Create own function blocks

Help

Edit Object

Add Action
New Folder
Expand Hade
Collapse Node

Name of the new POL:
Type of POU
" Program
% Function Block
€ Function
Retun Type:

Rename Objec!

0 Properties.
Project database »

B[=]8| Blleda2dg * [mm|6w

0001|PROGRAM PLC_|
0002[vAR
O0D3END_VAR

ST ——

CIL

C LD
& FBD
G
£ 251
¢ ICEE

=
MyOwin 0K
Language of the POL Cancel

Next steps to build the new project are to add a new object and select the “Program
Organization Unit” “Function Block”. In this exercise we use programming language

“Function Block Diagram”.
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Build the program
= Now insert the blocks ~—— Si@ MbieleeE = siwia]

® Open a new Network
-> Right mouse click on Network 1, select

Network (after) =& R \
Paste Chrl+y

Delete Del

block1

Network AND RS
0 ch s 27 SET
Inpul Chrl+1 777 RESET1 &p =
vl'ggl[% block1 277 o j

. [™® : RS : 227

222 RE;ET1 5135 e
3 = j = [nsert the other blocks in
: Network 2 and connect
%ﬁ o— block2 them
%g | INT_TO_TIME i TON L
%% i PT ET—
A DD
FAIDID

When the new network is designed, we have to put in the several function blocks. If Network
1is ready, we add a new network after the first one and put in the other blocks. It will be
avoided to split the whole program in several networks. So, it is easier to document the
networks and get an overview about the whole program.
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Input variables
m  Name the variables

(e.g. In1) o[ T T e }
x
m Click Enter (.J) and the ﬁ?" o ]
Declare Variable - - —
Window is opened I L
m  Declare the variable Class Name | Type
VAR INPUT Inl BOOL
Class: VAR_INPUT (FB input) VAR NPT |12 | B06L
Name: In1 VAR _INPUT Resetl | BOOL
’ VAR _INPUT Reset2 | BOOL
Type: BOOL VAR INPUT | TimeS | Int

m  When the settings are correct, click OK
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Next step is to declare all variables. This point is important because it must be defined which
variables are inputs, outputs or internal variables. For our example we declare the variables
like in the table.
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Output variables
m To declare outputs, mark
the output and create an
assign blockt
RESET1
SIEAR| 3 BI@IRE [ <] 8]w/E]]]
T
0009VAR_OUTPUT
5 i "
HL At the_ output appear - By
s, question marks il e N
o2 Reset! -
3& esel2+
22 s AL D HD
APpD
88

In programming language “Function Block Diagram” the first output at a function block has
no connecting point. So we have to add a “Assign” and question marks are shown on the
output. Now a variable for the output can be defined.
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Output variables

0001[FUNCTION_BLOCK MyOwn

VAR_INPUT
m Declare all outputs like in In2.800L,
Reset1: BOOL,
the table: TmeS. T,
END_VAR
Class Name | Type VAR'C:UTBUJUL
VAR _OUTPUT | output | BOOL Wileno VAR
VAR signall | BOOL | | —
block1: RS;
signall: BOOL,
1
Joo1
. . ) ) blockl
m  Finish the program like in wid Lo '*;p o1 —signan
. . In2+ RESET1
picture on the right! ’
Reset! - o
- Reset2-
g
§ 002
: ! T
3 INT_TO_TIME .
;E TimeS ‘,_1—::4T @ L puf_|
<a
4 AL 1D HD
¢ Mppw
88

We have 1 output of the new function block. Now this variable must be declared as output
variable. The picture on the right side shows the several variables for the function block. We
have input variables, output variables and internal variables.
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Call the own function block

m Change to PLC PRG

m Insert the following three blocks:

0 block @ out

MyOwn DigOut
In1 output bDOut

In2 wChannel

Reset]

Reset2

Times
10000

®m The box in the middle is the own function block

m  The other blocks are system blocks for DCS800
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When the new function block called “My Own” is ready we can work with them. So, we
change to the POU “PLC_PRG” and build an application like in the picture. Now the project
is ready, and we can test it.

10
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Test the program

= Build your project (F11)

m  Configure the communication to the DCS800
m  Set the task configuration

m Login and test your program
in ] hlock Ej out

MyOwin DigOut
In1 output} bDOut

In2 wChannel
Reset!
Reset2

’iTimeS

Correctfunction:

If DI1AND DI2 are TRUE, then after 10 seconds the outputis TRUE
With DI3 OR DI4 you can Reset the output (DO1 = FALSE)
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Build the project and configure the communication channel to DCS800. Set the task
configuration and login with the program.

The correct function of this application is a delay of 10 seconds if digital input 1 and 2 are
set.
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Exercise 8: Libraries

m  The own function blocks can only used in the program
in which they were written

m  To use them in other programs, they must be imported
into libraries

m |tis possible to protect libraries with passwords

m Libraries use the extension *.lib
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The next exercise deal with library handling. Own function blocks can only used in the
program in which they are written. To use them in other programs, they must be imported to
libraries. It is possible to protect libraries with passwords.
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Export function blocks

m  The own function blocks must be exported if they
should be available in different programs

Project Insert Extras Online ‘Window
Build F11
Rebuild all

| | Export Clean all
. Load download information. ..
-> Project > Export...

Object »
Project database >

= Choose the function block (FB) to be
expo rte d a n d C I i Ck O K Translate into other languages >

Document...

Import...
Siemens Import »

Merge...

%
OK Compare. ..
_Corcol |

B3 POUSs l Gl Project Infa...
T W Global Search. .
[d PLC_PRG (PRG) Global Replace. ..
2 Resources

(1 Global Variables

‘\EAIavm configuration
i B Library Manager
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There can be a need to use this function block in other projects. This is possible when the
function block is exported to the other project.
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Export / import function blocks

Export Project

i K
=  The window Export o[ v Henam
- = ] MYOWN.EXP
Project is opened

T

m Choose a File name

m Click Save e Coee ]
Save astype: [CoDeSys Export Fie [*.exp) | Cancel
m  Open another program
i
= Import the function block === LIS EIchES:
- Project - Import...
¢ m Choose the file to import N
g
;é:q [} Click Open Flename:  [MYOWN.EXP Open I
g‘u;,l Fles of type: [ CoDeSys Export Fie [* exp) | Cancel
§E = The function block is
i imported AL 1D D
P FAIDED

To export function blocks, define a name for the export file, please. Import of function blocks
which are saved into other projects is very easy.

Open another program and click import to add the function block.
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Create libraries

: savens 2| x
m Create a new library N T il
> File > Save as -
m  Select library type
-> Internal library
m  Chose a File name for theN ... e =]
Iibrary Save.as pe: [CoDeSys Project (- pro) = Cancel |
CoDeSys Project [*.pro] -
= Save the library Pl
Exlevqal Iibv;y \:e!sif?n 2 ? [;‘.I\b]

Note:
Internal library:  libraries which are written with the five IEC languages
External library: libraries which used other programming languages (e.g. C)
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If a new library should be created click to menu “File” the item “Save As” and select “Internal
library”. Now all function blocks which are included in the project, will be saved in a new
library. It isn’t possible to save programs in a library structure. Only function blocks are
inside a library.
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Insert libraries

m Select
-> tab Resources > Library
Manager

m Available libraries are
shown

m Insert a new library
-> Insert - Additional Library...

m Choose the directory in
which the new library is

¥ located

g

:. ™ Mark the library and
it click Open

Help

Standard lib 22.11.02 10:08:30
lecSfc lib*26.11.02 09:23:26

12 Resources
B[] Global Variables

@] library DCS800IL]YS 22.9.05 08:34:3| |SysLibTime lib*8.10.03 16:33:40

B fbrary lecSfo ib26 11.020323.26: | |SysTaskinfolib 8.10.0315:33:40 |
B (] librany Standard ib 22.11.02 10:08:3 '
B[] libraty SysLibTime.ib"8.10.03 16:33

B[] library SysTaskinfo ib 8.10.0315:33 | _’J

(4 Alaim configuration

%0 | l'J PT?U:J‘ N I

Insert Extras Onlne Windo

ooen 2

Lk [Oey ] @ @ ek
[ =3 Anslyzation i =TT
| = Anatyzatiordew. i = wi_no_Real ib

3 checkib

| tecsfc.bb
|58 standard LIB

Fiopame:  [DCSB00 own function blocks ib

[ o ]
e R e

Libeary deectory: | \Program Hes\3S Soltware\CoDeSys V2 \Lixary' ¥

The next question is how libraries can be embedded to projects. For this case you can find

the “Library Manager” in CoDeSys. Insert libraries with “Library Manager” when you click to

“Additional Library”.

The library manager shows you all available libraries like the “DCS800 Library” or the

“Standard Library”.
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Insert libraries
m Check if the new library is installed

- CoDeSys - DCSB00 user defined events.pr o * - TLibrary Manager]
@D Fie Edt Project Insert Extras Onk indowh Help

cks [FUNCTION_BLOCK MyOwn
32, Resouces ib[2.3.06 09:37:44 [VAR_INPUT
| B3 Global Varisbles Standard lib tru 0512:14:46 In1: BOOL;
| [~@ GlobaL vasisbles || [lecSfc.ib 26.1) 02 10:23:26 In2: BOOL;

| @ Variable_Configueal| [SysLibTime.ii§ 8.10.03 17:33:40
B33 vy DCSB00 own furf| [SYSTasKInfo.lip 8.10.03 16:33:40
B library DCSB00Rb.Ib 2.3
B fbrary lecSfe.lib 26.11.
B3-(2] fibeary SysLibTime.ib 8.1
-0 ibray SysTaskiniolbg| [ =y ous

e | 0 T —

Reset1: BOOL;
Reset2: BOOL;

Log
() Parameter Manager
({3 PLC Configuation
] Samping Trace
A Target Setlings
(&8 Task configuration
Q, Watch- and Recipe Ma
-3 Workspace

|
: MYOWN

!
[
! nTMBOOL output : BOOLF—
in2 : BOOL

Reset! : BOOL
Reset2 : BOOL

{Times : INT

i1 /]

(8] Pous™= Data .
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If the new library is correctly installed, you can find the library name in the directory and see
the available blocks.
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Summary

Key points of this module
m Create new function blocks

® |mplement function blocks into libraries
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Help

Key points of this module are to create new function blocks and implement them into
libraries.
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Additional information

® Links to related information
- 3S-software.com

- DC-Drive-News (Intranet)

m Additional references
- Application Manual (3ADW 000 199)
- Firmware Manual (3ADW 000 193)
- Hardware Manual (3ADW 000 194)
- Training Material

Help
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Glossary

m CoDeSys
Controller Development
System (software tool)

= Memory Card
Flash memory

= DriveWindow Light
Software Tool for
commissioning and
maintenance using AC/DC

= Target
Interface between Drive
and CoDeSys tool

Control Builder
Whole system with
software and hardware

PLC_PRG
Main program which is
used in all applications

POU
Program Organization Unit

Library

It includes function blocks
which are given or
designed by other users

AL IDED
Mpmp
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Power and productivity
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Thank you for your attention. You may now go ahead and move on to the next unit.
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